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Saving Results

Once Hunter has completed a successful search, you may save the results in a text file (the 
results are what you see displayed in Hunter's main window).    Select File then Save As... 
from the menu.    Hunter will prompt you for the file name and directory.

If you wish, Hunter will save its results using tabs rather than spaces.    This "tab delimited" 
format is understood by many spreadsheets and word processors.    To save using tabs, 
select File and Save As... from the main menu then select Tabbed Text (*.TXT) from the 
Save File As Type: edit box.
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Registering Hunter

To register your copy of Hunter please send $15 to:

Peter Eddy
1454 Beacon St.    #244
Brookline, MA    02146

Tel: 617-739-0018
CIS: 71541,1420
Internet:    (via Compuserv)    71541.1420@compuserve.com

Because of the low cost of Hunter and the high cost of mailing disks, I prefer to distribute 
updates through CompuServe (type GO WINADV or GO WINNEW).    If you don't have access 
to a modem or CompuServe, write me at the above address and include a disk (3.5 or 5.25 
inch), a reusable mailer, and return postage.    Let me know the version of Hunter you're 
using (it's in this file and in Hunter's about box).    If you've got the current version I'll keep 
your disk until the next one is released, otherwise I'll send you the most current one.    If 
you'd rather I just send you Hunter, I'll provide the disk, mailer and postage for $5 (US or 
Foreign).

I'm sorry but I am not able to accept credit card orders at this time.

Outside the United States
There are two payment options for customers outside the U.S.

1.    A check drawn on a bank in your own country in your own currency at the current 
exchange rate for the total amount of US dollars plus two additional dollars.    The two extra 
dollars covers the    charge which I incur to cash the check.    Please do not send checks 
drawn on your local bank in US dollars, the service fee is more than the value of the check.

2.    A check for the total amount drawn on a US bank.

Checks drawn on Greek or Spanish banks must be marked "convertible", Italian bank checks 
must not be marked "non-transferable".

I appreciate the extra effort involved in registering Hunter from outside the US and wish to 
thank everyone who has already done so.

This is a free upgrade for previously registered users.    It's also free to public schools and 
non-profit organizations.    The $15 is for individual use, please contact me for site license 
information.



See your DOS manual for more information on hidden and system files.



Finding Text Within Files with Grep

To locate text in a file, enter the text you would like to find in the Grep String edit box on the 
Search Specification dialog box.    All files specified in the File Names edit box will be 
searched for the text you have entered.    Hunter does not distinguish between upper and 
lower case.

Turning off Text Search
If wish to search for files only, simply clear any text from the Grep String edit box.

Advanced Searching
Hunter is not limited to simple search strings.    The search string can contain very handy 
items called regular expressions which are similar to, but more powerful than, wildcard 
characters for DOS file names.    To find out more about advanced searching select Regular 
Expressions from the topic list below.

Related Topics
Regular Expressions
Line Numbers



Line Numbers

Hunter cannot reliably report line numbers for files other than plain old DOS or ASCII files.    
This is because Hunter counts lines by the number of carriage return characters it finds in 
the file but most modern word processors don't use the carriage return character or use it 
only in special circumstances.



Regular Expressions and Grep
Hunter uses regular expressions to locate patterns in files.    In these expressions, upper and 
lower case differences are always ignored and blank lines never match.    An ordinary 
character (not mentioned below) matches itself.    The following characters have special 
meaning:

^ A circumflex at the beginning of an expression matches the beginning of a line.    Use 
^dear to find all lines in files that begin with the word dear.

$ A dollar sign at the end of an expression matches the end of a line.
. A period matches any character except a new line.
A colon matches a class of characters described by the following:
:a Matches any alphabetic, i.e. A to Z, regardless of case.
:d Matches digits (0 to 9)
:n Matches alphanumerics (alphabetic or digit)
: A colon followed by a space matches spaces, tabs and other control characters 

including newline
* An expression followed by an asterisk matches zero or more occurrences of that 

expression.    Unlike DOS wildcards, 'to*t' matches 'tt' as well as 'tot', 'toot', and 
'tooot'

+ An expression followed by a plus sign matches one or more occurrences of that 
expression.    For example 'to+t' matches 'tot', 'toot', etc.

[ ] A string enclosed in square brackets matches any character in that string, but no 
others.    If the first character in the string is a circumflex, the expression matches any
character except a new line and the characters in the string.    For example '[lrc]ain' 
matches 'lain', 'rain', and 'cain' but not 'fain'.    '[^lrc]ain' matches 'fain' but not 'lain', 
'rain', or 'cain'.    A range of characters may be specified by a '-'.    The expression '[b-
g]oat' matches 'boat', 'coat', and 'goat' but not 'moat'. 

 - An expression followed by a minus sign optionally matches the expression.    So 'too-t'
matches 'toot' and 'tot'.    A minus sign appearing within square brackets is treated as
an ordinary character if it is the first or last character in the expression, otherwise it is
treated as a range.      '[a-c]rt' matches 'art', 'brt', 'crt', and '[-ac]rt' matches '-rt', 'art', 
and 'crt' but not 'brt'

\ The backslash quotes any character.    It's usually used to match one of these special 
characters.    Example: \$ matches a dollar sign, \\ matches a backslash.    Optionally 
the backslash can be followed by ASCII digits representing the character value:    \65 
matches 'A' and 'a'.

Examples
October
Matches the word October regardless of case.
colou-r
Matches color or colour:    The 'u' is optional because of the '-' sign.
gr[ae]y
Matches gray or grey.
\$    *:d+
Matches dollar amounts.    Remember that the dollar sign ($) itself is a special character and 
must be 'quoted' (made to be treated as a normal character) by the backslash (\).    The '      * 
' allows for spaces between the dollar sign and the first digit of the amount.    The ":d+" 



specifies that the dollar sign must be followed by one or more digits.
:d:d-/:d:d-/:d:d:d-:d-
Matches dates like 3/1/61 and 10/14/1991
:d:d:d[ -]:d:d:d:d
Matches US style telephone numbers:    Three digits followed by a space or a dash ("[    -]"), 
then four more digits.    Note that the special character '-', need not be quoted within 
brackets. 
(-:d:d:d[ )-]- -:d:d:d[ -]:d:d:d:d
Matches long distance, but not local, telephone numbers:    An optional open parenthesis 
("(-") followed by three digits (":d:d:d"), optionally separated by a space, a close parenthesis,
or a dash ("[ )-]"), optionally followed by a space (" -"), followed by three more digits, a 
space or a dash (" -"), followed by four more digits.    Because the format of local numbers is 
a subset of long distance ones, the simpler local grep string ":d:d:d[ -]:d:d:d:d" will also 
match long distance numbers.
(-800[ )-]- -:d:d:d[ -]:d:d:d:d
Matches 800 telephone numbers only



About Grep
GREP stands for Gross Regular Expression Parser and has its origins in UNIX.



The decimal number 65 is the ASCII representation of the letter 'A'.    Because Grep is not 
case sensitive, it will also match 'a'.



 Search Prompt

Before you begin a search you must tell Hunter what to look for.    Hunter can prompt you for 
this information when it is first loaded and/or when you press Go!    By default Hunter 
prompts you in both cases.    If you wish to change this behavior you may with the Search 
Prompt option.    Select Make Options Default from the Options menu to make the new 
settings default.

Note:    If you choose to disable the search prompt for the Go! menu option Hunter will 
execute a search based on the default search specification or whatever was entered last in 
the Search Specification dialog.    If you wish to change the search specification, you must 
select Search... from the File menu.



First File Only

When this option is selected, Hunter will stop searching as soon as it has found the first file 
that meets the search criteria.



Use Environment Path Only

Selecting this option instructs Hunter to search only the directories listed in the PATH 
environment variable.    This option is useful for finding duplicate executable file names.



The PATH environment variable tells DOS where to look for executable files.    Most 
environment variables are set in your autoexec.bat file.



Show File Statistics

Selecting this option instructs Hunter to display found files size (in bytes), last modification 
date, and last modification time.    When disabled, only the file names will be displayed.



Monitor Progress

When this option is selected Hunter will display in the title bar the current number of files 
found, directories searched, and strings matched (if you're using Grep).



The Title Bar is the upper-most portion of the main window, typically where the application's 
name is displayed.



Color Settings

You can change the colors Hunter uses for the background, for file names, for found text, 
and for the launch box.    For best results, run a short text search and single click on a file 
then select Color Settings, you will then see the colors change as you modify them.    
Select Make Options Default after changing color settings to cause Hunter to use the new 
color selections the next time it's run, otherwise the color selections will be in effect for the 
current session only.



Make Options Default

Selecting Make Options Default instructs Hunter to remember all the option settings under 
the Options menu, and to automatically load them the next time it's run.

To save filespec options, push the Make Default button on the filespec dialog box.



Load Default Options

If you change settings and later decide you wish you'd hadn't, you can restore all settings to 
the last time you selected Make Options Default by selecting Load Default Options.



Go! and Stop! Commands

The Go! command tells Hunter to begin a new search.    By default Hunter prompts you for 
the search parameters with the Search Specification dialog box (you can change this with 
the Search Prompt menu option).    Once Hunter has begun its search you can select or load 
other applications and continue your work.    Hunter will work in the background.    You may 
stop the search at any time by selecting the Stop! command.

The Stop! command stops the search immediately and displays whatever information Hunter
has found.    You may begin the search again by selecting Go!



Finding Files

To find a file using Hunter you must first tell Hunter what files to look for.    By default, Hunter
prompts you for this information when it is loaded and also every time you press Go!    (You 
can change this with the Search Prompt option under the Options menu.)    You may enter
multiple file names which may contain wildcards.    For example, a typical entry might be " 
*.DOC    *.TXT *.WRI", for all document, all text, and all Microsoft Write files.    If you only wish
to find files, do not enter any text the Grep String edit box, or if this edit box already 
contains text, clear it.

File Details
Hunter will optionally search for files that are of a certain age and/or size.    To do this, select 
a relational operator and enter a number in the appropriate edit box.    For example "< 5" 
Days Old reads "Less than five days old."    The combination ">= 1000000" Bytes in Size 
reads "Greater than or equal to 1 million bytes (1MB) in size."

If you do not wish to use an age or size limit, simply clear any values in the appropriate edit 
boxes, the logical specification will then have no effect.

Hidden and System Files
Hunter will also search for hidden and/or system files.    System files are those files marked 
for use by DOS itself.    Normally system files are also hidden, so select both hidden and 
system to find these files.    Most users very rarely create or need to search for these types of
files so this option is not normally selected.    

Make Default
Push this button to cause the currently selected filespec options to become the default.    
Hunter will then automatically load the settings every time it's run.

Related Topics
Finding Text in Files
Go!
Launching Applications



Wildcard characters are * and ?.



Relational Operators:
These are the relational operators supported by Hunter.

> Greater Than
>= Greater Than or Equal
= Equal
< Less Than
<= Less Than or Equal



Launching Applications
In addition to simply viewing results, Hunter is able to run other applications.    Say, for 
example, you searched for all executable files (*.EXE, *.COM) on your hard disk.    You may 
double-click on any file name listed and Hunter will load and execute that program.    If you 
double click on the path name, Hunter will load the MS-DOS Executive that's so familiar to 
users of pre-3.0 Windows.

Associations
You're not limited to directly launching executables, however.    You may also double-click on 
non-executable file names like those with .DOC and .TXT extensions.    This will cause Hunter 
to automatically load and run the associated application with the file that you've clicked on.   
Try it!    Run a search on all text files (*.TXT).    When Hunter's done, double click on one of 
the file names.    In a typical installation of Windows, the Notepad application will pop up, 
loaded with the file name that you've just selected!    Double-click again.    Another Notepad 
application pops up!    When you're done, close the applications normally.

Making Associations using File Extensions
How does Hunter know what application to load when you double click on a non-executable 
file?    Simple:    You tell it.    You can add associations by selecting File and then Associate... 
from the File Manager's menu.    If you want to know more about associations, refer to your 
Windows documentation or File Manager's on-line help or read the following short 
paragraphs.

Windows maintains a list of associations in the win.ini file that say, essentially, a file with this
extension belongs to that application.    For example, here's an abbreviated version of the 
association list in my win.ini:

[Extensions]
txt=notepad.exe ^.txt
ini=notepad.exe ^.ini
doc=\windows\winword\winword.exe ^.doc
dot=\windows\winword\winword.exe ^.dot
rtf=\windows\winword\winword.exe ^.rtf
xls=excel.exe ^.xls
xlt=excel.exe ^.xlt

As you can see from this list, NOTEPAD.EXE is associated with files ending in .TXT and .INI.    
This is how Hunter knew to run Notepad when you double-clicked on a .TXT file in the 
example above.    Note that most well written Windows applications will automatically add 
their associations to this list when they're installed or run for the first time but normal DOS 
applications never do.    To make Hunter load my DOS editor (Brief) when I double click on a 
file with a .C extension, I've added the line:

c=b.exe ^.c

to my win.ini [Extensions] list.    To find out more about using this feature refer to your 
Windows documentation.



A file extension is made up of the optional three letters following the period in a file name.    
For example, in the file name README.DOC, the letters "DOC" are the extension.


